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Abstract 
Quantifying belowground dynamics is critical to our understanding of plant and 

ecosystem function and belowground carbon cycling, yet currently available tools for 

complex belowground image analyses are insufficient. We introduce novel techniques 

combining digital image processing tools and geographic information systems (GIS) 

analysis to permit semi-automated analysis of complex root and soil dynamics. We 

illustrate methodologies with imagery from microcosms, minirhizotrons, and a rhizotron, 

in upland and peatland soils. We provide guidelines for correct image capture, a method 

that automatically stitches together numerous minirhizotron images into one seamless 

image, and image analysis using image segmentation and classification in SPRING or 

change analysis in ArcMap. These methods facilitate spatial and temporal root and soil 

interaction studies, providing a framework to expand a more comprehensive 

understanding of belowground dynamics.  
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Chapter 1: Beyond roots alone: novel methodologies for 
analyzing complex soil and minirhizotron imagery using image 
processing and GIS tools1,2 

 
1.1 Introduction  

1.1.1 The opportunity 

Belowground image analysis has most commonly focused on quantifying root 

dynamics (Chapin & Ruess, 2001, Farrar & Jones, 2000, Jackson et al., 1997, Johnson et 

al., 2006, Trumbore et al., 2006). However, comprehensive monitoring of visible 

manifestations of physical, chemical, and biotic dynamics belowground is essential to 

advance understanding of otherwise hidden soil processes that regulate nutrient cycling, 

greenhouse gas flux, and soil carbon (C) sequestration. Important visible belowground 

physical processes include soil wetting fronts, frost heaving, and changes in pore space. 

Visible chemical changes include redox-dependent reactions, e.g., gleying/mottling of 

soils; oxidation of organic matter by decomposers; and the formation of methane as 

manifested in gas bubbles in anoxic wetland soils. Common visible biotic dynamics 

include root and fungal demographics, root herbivory and fungivory, macroinvertebrate 

distribution and phenology, and soil macrofauna. Including these factors in belowground 

monitoring would contribute to a holistic approach that is imperative to advance 

understanding in the face of challenging fundamental and applied problems.  

                                                 
1 This research will be submitted to a peer-reviewed journal for publication. 
2 All images and software screenshots were created using ArcGIS® software by Esri. ArcGIS® and 
ArcMap™ are the intellectual property of Esri and are used herein under license. Copyright © Esri. All 
rights reserved. For more information about Esri® software, please visit www.esri.com. 
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We do not mean to downplay the importance of roots, which have directly measurable 

multi-scale importance, from individual physiological processes, through ecosystem level 

nutrient dynamics and soil organic matter accumulation, to global scale C cycling. Short-

lived fine roots represent a substantial input of organic matter and nutrients into the soil 

(Rasse et al., 2005). Mycorrhizal fungi are a significant mediator between root and soil 

nutrient uptake and have a substantial impact on carbon sequestration (Veregsoglou et al., 

2012). Soil organic matter stores three times more C than the atmosphere or terrestrial 

vegetation (Schmidt et al., 2011). Given anthropogenic changes in global C cycling and 

their impact on global climate, it is imperative to understand this complex system (Wan 

et al., 2004). Yet the indirect effects of changing climate and CO2 on belowground 

carbon allocation are poorly understood. A better understanding of root dynamics and 

their effects on soil biogeochemistry is vital, and non-destructive root and soil imagery 

analysis is requisite for advancing understanding.  

Methods for quantifying root growth spatially and temporally using non-destructive 

methods rely heavily on minirhizotrons, transparent tubes placed permanently in the 

ground for imaging the rhizosphere (Iversen et al., 2012, Taylor et al., 2014). There are 

numerous methods for processing minirhizotron imagery, whose strengths and 

weaknesses are discussed elsewhere (Milchunas, 2009, French et al., 2009, Iversen et al., 

2012, Rewald & Ephrath, 2012, Vamerali et al., 2012). Despite the plethora of 

minirhizotron image analysis techniques, long processing time creates a bottleneck that 

limits advancement in root demographic studies. To study root demography, images are 

captured at frequent intervals (Rewald & Ephrath, 2012), often leading to massive 
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backlogs of unprocessed data. Furthermore, these images encompass a very small area 

and provide limited information on root system integration. 

Beyond minirhizotron techniques, methods for analyzing larger complex root imagery 

are rudimentary. We have not found an automated method that accurately and efficiently 

determines root lengths and areas in large complex images with dense root systems 

grown in natural media. As for minirhizotron image analysis, existing image analysis 

approaches (Majdi, 1996, Vamerali et al., 2012,) can be quite time consuming and 

require substantial input from the analyst.   

The importance of standardization in using images to perform root and soil 

observational studies has yet to be addressed in the root studies literature. Resisting the 

need to enhance imagery is discussed in Rossner & Yamada (2004) in terms of cellular 

biology; however the same principles need to be considered in belowground image 

processing. Arbitrarily enhancing an image can produce false turn-over rates as a tan root 

could appear white under the incorrect lighting. In particular, the issue of color 

consistency is a considerable challenge when conducting experiments of this kind.  

There is a critical need for improved knowledge on fine root structure, quantities, and 

demography, on as many plant species as possible, for better management and predictions 

on biogeochemical processes (Pierret et al., 2005, Smithwick et al., 2014). Belowground 

images contain a wealth of valuable information beyond just roots. Many of the physical, 

chemical, and abiotic processes occurring belowground are amenable to image analysis 

(Downie et al., 2014). To our knowledge no other methods have the advantage of 

simultaneously tracing roots while additionally quantifying other phenomena of interest. 

We see this as a missed opportunity when such a large wealth of belowground data is 
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being collected in every image. These analysis procedures fill a need for consistent and 

accurate tracing capabilities and flexible data management via attribute tables in ArcMap.  

1.1.2 New approaches 

 To address these limitations in belowground image analysis, we need easily 

implemented tools for visual analyses of complex root system dynamics and other soil 

processes. We propose applying methodologies widely employed and accepted in the 

fields of remote sensing and photogrammetry. The issues faced while studying 

belowground imagery are remarkably similar to those encountered with aboveground 

remotely sensed data, including: large data sets, finding areas of discrete features such as 

lakes and streams or lengths and widths of roads, change detection and rates of change, 

and transformation of the imagery to improve interpretability. Here we introduce an 

innovative application of GIS and remote sensing techniques for the study of roots and 

soil processes, starting with guidelines for image acquisition, followed by the use of 

software traditionally used at the landscape level: SPRING 

(http://www.dpi.inpe.br/spring/) and ArcMap (ESRI, Redlands, CA) for image analyses. 

Methodologies include image segmentation and classification, change analysis, and the 

use of basic ArcMap tools and functions. These approaches allow rapid classification and 

change analysis on large, complex belowground images. 

SPRING classifies the entire image utilizing image segmentation, which creates 

demarcated regions based on pixel proximity and likeness, with thresholds defining user-

generated classes. SPRING’s interface is user-friendly and requires no knowledge of 

computing syntax or direct use of complex algorithms. This approach differs from root-

centric segmentation algorithms such as Zeng et al. (2008, 2010), or Shojaedini & 
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Heidari (2013), which exclusively identify roots, ignoring rhizosphere processes. These 

methods also differ from a root-centric GIS-based approach proposed by Gasch et al. 

(2011), who use Feature Analyst to trace roots.  

To demonstrate its utility, in the following sections we present SPRING image 

segmentation and classification on three types of imagery with varying complexities. We 

also present a method utilizing ArcMap to perform change analysis using image 

subtraction. This method is commonly used with remotely sensed imagery (Singh, 1989), 

and performing this type of analysis in ArcMap is much simpler than methods requiring 

computing syntax. We performed image subtraction followed by thresholding to isolate 

the values that indicate change on sets of images that represent various soil-root 

conditions.  

In addition to seeking new methods to improve root and soil image processing, we 

created a novel approach for analysis of minirhizotron images. We mosaicked separate 

minirhizotron image segments into one continuous image to gain more information per 

minirhizotron tube. The single larger image allows quantitative image processing 

techniques to be utilized under conditions of soil and root movement, such as in peatland 

ecosystems (Iversen et al., 2012) or after frost heaving, which hinder the use of other 

image analysis software packages. Our novel methods for minirhizotron image analysis 

include image segmentation and classification for quantifying the standing crop of roots, 

change detection analysis to derive root production or turnover, and traditional manual 

tracing techniques using ArcMap in place of conventional root tracing programs. All 

involve the creation of individual root segments feature layers, which can be analyzed in 

the supporting attribute table. The creation of root segment layers in ArcMap enables us 
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to superimpose multiple images of root segments from multiple sample dates over one 

another. In the following sections we detail these novel approaches. 

 

1.2 Image Acquisition  

1.2.1 Image acquisition guidelines  

To view a digital image is to create a brightness map, i.e., a computer graphic display 

of brightness values (BV) based on reflectance from the feature of interest. Root color 

change (a change in BV) is the basis for determining root demography and tracing root 

perimeters. It is common practice to enhance root images to increase the contrast between 

the background and the features of interest, which is acceptable when manually 

interpreting a single image. However, when multiple images are being analyzed using 

semi-automated procedures, standardization of BV between images is essential to obtain 

correct measurements (Plataniotis et al., 2000). This means camera settings, imaging 

distance and lighting conditions, and image enhancements must be consistent for all 

image acquisitions. It is also important to ensure that bright objects are not overexposed 

when photographed, because overexposure essentially chops off the upper end of the BV 

range.  In minirhizotrons, fully blocking incoming sunlight is essential to maintain 

constant BVs, as it contributes inconsistent light to the top frames in a minirhizotron tube. 
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Figure 1.1 illustrates the importance of standardized image acquisition parameters 

with mosaicked minirhizotron images, each consisting of four frames. Each frame was 

acquired with different camera settings, resulting in inconsistent BV for roots and peat 

from frame to frame. Figure 1b displays the same minirhizotron area as Figure 1.1a after 

3 months. Within the second frame in both images, the peat is darker in Figure 1.1a than 

in 1.1b, raising questions regarding the “true” color of the roots. In addition to interfering 

with quantitative color comparisons over time and space, the image-to-image 

inconsistency also prevents the image mosaic from appearing seamless.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.1 Two sets of minirhizotron images, acquired at different times that have 
been mosaicked together demonstrating the importance of camera setting consistency. 
(a) Image acquired June 2011 with different settings for three frames, (b) Image 
acquired September 2011 again with different settings between frames.  

Fig. 1.1a Fig. 1.1b 
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Inconsistent enhancements that change the apparent color of roots can cause 

underestimation of maturation or turnover rates.  Figure 1.2a, a color-standardized image, 

shows a dark brown root, indicated by the green arrow. However, Figure 1.2b shows the 

same root now lighter in color due to image enhancement. This image is over-exposed, 

and the BV enhanced to make the fine roots stand out (blue arrow) at the expense of 

overall image color. The fine roots in Figure 1. 2b are more apparent than the fine roots 

in Figure 1.2a (blue arrows), but this enhancement is unacceptable for quantitative color 

change measurements. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.2 Consecutively acquired images: (a) has been color corrected with a 
Macbeth ColorChecker (b) had brightness and contrast adjusted to make fine 
roots more visible.  

Fig. 1.2a Fig. 1.2b 
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If standardized camera settings and lighting conditions are not possible, color 

correction via use of a standard color scale, e.g., Macbeth ColorChecker card (X-rite 

photo Part# MSCCC), should be considered. The card is a checkerboard array of 24 

colored squares in a wide range of colors, providing the needed baseline for comparing, 

measuring and analyzing objects when true color is required. In cases where enhancing 

contrast is necessary to make roots or objects more apparent, it is good practice to take 

two images, one for quantitative color analysis and one for growth measurements. 

External lighting is an important consideration in imaging soil systems, as various 

bulbs emit different wavelengths of light which ultimately affect the color temperature of 

an image. Fluorescent bulbs produce the whitest light, but may not be appropriate in 

some systems. Having consistent illumination across an imaged surface is also important, 

especially when using segmentation algorithms, as it changes BV (Gijsenij et al., 2012). 

Using an external camera flash attached to the camera can provide more consistent 

lighting compared to lamps, because of control over shutter speed and aperture 

(Persichetti et al., 2007). Regardless of the bulb type, it is important to maintain lighting 

brightness, temperature, and intensity for color consistency.  

Additionally, camera type may affect image color. It is impractical to suggest all 

imagery be acquired using an imaging spectrometer which records light intensities at 

varying wavelengths, as opposed to commercially available SLR or CCD digital cameras 

that record visible and near-IR reflectance. However, it is important to recognize that the 

bandwidths (spectral resolution) labeled blue, green, red and near-IR will vary between 

camera brands and models. Hence it is recommended the same camera, lens, and filter be 

used for image acquisition during the life of a project.  
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1.2.2 Image acquisition guidelines in use 

To demonstrate these guidelines, we used images from three different types of 

experimental systems: experimental microcosms, wetland minirhizotrons, and an upland 

rhizotron facility.  The microcosms are small plexiglass containers filled with peat and 

wetland plants. The microcosms are used to represent a diversity of complex densely-

rooted systems. A Nikon D90 camera was used with fixed settings of f-stop/6.3, exposure 

time 1/160 second, flash off, and an ISO of 640. We used a Nikon micro lens with a 90 

mm focal length and a spatial resolution of 0.125 mm. The camera was mounted to a 

stationary fixture to maintain image capture distance and minimize blur. Blur produces 

false areas with large-scale imagery especially when using semi-automated image 

segmentation procedures. A stage was built to hold the root windows and the camera 

stand was attached. For lighting, we used frosted photoflood bulbs (SYLVANIA 11560) 

mounted on light stands situated to eliminate glare and produce even illumination. To 

ensure color consistency we also used a MacBeth ColorChecker. After capture and color 

correction, these images were registered to a planar X, Y coordinate system (see 

supplementary protocol for instructions).   

Minirhizotron images came from the USDA-Forest Service Houghton Mesocosm 

Facility, where 24 1-m3 bins containing peatland plant communities are instrumented to 

investigate carbon dynamics in a changing climate (Potvin et. al., 2014); within each bin 

is a minirhizotron tube in which images were collected monthly using a Bartz BTC-100x 

minirhizotron video microscope (Bartz Technology Corp, Carpinteria, CA). Prior to 

analysis, imagery from each tube was mosaicked together with a provided ArcMap Tool. 

The tool automatically stitches images together into a single seamless image, allowing for 
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analysis of the entire minirhizotron tube rather than individual small regions.  This allows 

analysis of entire root segments that span numerous frames, a significant advantage over 

traditional methods. Having the minirhizotron images stitched together also allows faster 

processing times using image segmentation and image subtraction.  

Rhizotron images came from the USDA-Forest Service Houghton Rhizotron Facility, 

which consists of 24 1.5 x 1 m windows providing access to two different forest and soil 

types.  Two types of imagery come from the Rhizotron, automated time lapse 

photographs and manual photographs. The automated photographs are taken every 30 

minutes using a Nikon D50 with a 60 mm f/2.8 D AF Micro-Nikkor fixed lens with an 

infrared (IR) light source (www.surveillance-spy-cameras.com, Part# SSC IR104 940W). 

In order to take images with an IR light source our camera was modified 

(www.maxmax.com) by removing the IR filter, extending the recorded wavelengths from 

the UV range through the IR range (330nm-1200nm), as opposed to standard cameras 

recording wavelengths between 400nm-780nm. Lighting, camera settings, and 

positioning remained consistent between image capture sessions. 

Manually captured photos were taken using a custom-made metal imaging box with a 

stationary synchronized Nikon flash at each side, directly facing each other for complete, 

glare free, and consistent illumination. The camera used is a Nikon D50 with a 60 mm 

f/2.8 D AF Micro-Nikkor fixed lens. The distance from glass to lens is fixed. However, 

the imaging box is moved between the window panes, so the images taken in different 

sessions do not line up perfectly and had to be georeferenced to one another. 

Georeferencing is the process of aligning images via an affine transformation to ensure 

they occupy the same spatial location. This is accomplished by using a minimum of three 
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control points, which are visible features located in the same place on all the images. The 

resulting geospatially referenced images can be overlaid and compared quantitatively and 

qualitatively. ArcMap’s online resource center (resources.arcgis.com) provides details on 

georeferencing. All but one set of images for the study was georeferenced using this 

process. 

1.3 Image Analysis Methodologies  

Method of analysis depends on the question and image content. The best analysis 

methodology must be determined by the analyst, emphasizing the art and science that is 

image processing. Gaining familiarity with these methods and their final products is key 

in optimizing the functionality of these tools. 

1.3.1 Attribute table  

ArcMap maintains data associated with features in the attribute table. By accessing the 

information in the attribute table each soil feature is associated with its own attribute ID. 

Additional data can be entered pertaining to a particular polygon; for example, directly 

measured variables such as root diameter, color values, species, branching order, or soil 

depth can be added. The Field Calculator within the attribute table allows the entrance of 

equations for scaling or correction factors, and the Calculate Geometry function permits 

automated length and area calculations. Keeping track of objects from prior imaging 

sessions is done by copying the first session features to the next and re-naming. Soil 

features positions can be changed when needed; this maintains the attribute table data and 

retains feature’s unique identities.  Furthermore the use of the attribute table enables data 

queries for comparison of root variables over time for better predictions and deeper 
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understanding of these complex networks. All of the following methodologies for 

measuring soil features involve the use of the attribute table. 

1.3.2 SPRING Segmentation and classification  

SPRING is an open source image processing software package which uses image 

segmentation as a classification procedure (Camara et al., 1996, Bins et al., 1996). Image 

segmentation is a region-growing approach using an algorithm that defines regions within 

the image based on pixels (seeds) initially defined as unique regions. From these seed 

pixels, regions are grown by merging neighboring pixels with similar properties 

(similarity) based on the pixel BVs. The algorithm employs a user-defined similarity 

parameter that defines region boundaries. The smaller the similarity value chosen, the 

more similar the BVs of neighboring pixels have to be to be considered the same region. 

A different region is created when the similarity value is exceeded. Once regions are 

established they are combined with adjacent regions based on the BV value similarities 

and minimum region size perimeter as specified by the user.  

Once classifying an image there are a number of considerations. When defining 

classification regions, it is imperative to select well-distributed regions over the entire 

image. The number of classes needed depends on the color variation of the image and the 

goals of the classification. An image with uniform soil color will have a class for soil and 

several classes for roots depending on the BV variation. Finding the best similarity and 

minimal region size combination for an image (or set of images) is an iterative process 

and requires analyst involvement. The differences between soil and root (or other matrix 

and object) color in any given image is the basis for determining similarity value. If the 

roots and soil have similar colors, starting with a smaller similarity value will potentially 
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Image Type Similarity Value Minimal region size
Rhizotron 16 100

Minirhizotron 10 100
Microcosm 5 20

provide the best results. If the soil and roots have good color contrast, a larger similarity 

value is more appropriate. As new phenomena appear in a set of images the similarity and 

minimal region size parameters may need to be adjusted.  

Optimizing minimal pixel region size is also critical for discrimination between roots 

and soil. During classification, if minimal pixel region size is too small, soil pixels with 

coloring similar to root pixels will be misclassified as roots. Table 1 displays the optimal 

similarity value and minimum region size for each image analyzed with SPRING. In 

Figure 1.3 there is a portion of a complex root image displaying the steps taken in 

SPRING to segment and classify an image. Figure 1.3a is the original image; there are 

slight variations in the BVs of each individual root that could cause roots to be broken 

into multiple classes. To overcome this problem, a larger minimal pixel region value will 

force these spectrally varying regions to stay together (Fig. 1.3b), thus minimizing the 

possibility of an incorrect classification. To initially check the segmentation and 

classification results, examine the smallest roots in the image; they should be accurately 

outlined, meaning areas of adjacent soil are separated from segments of root as in Fig. 

1.3b. In Fig. 1.3c the fine roots are clearly classified in a fine root region versus a soil 

region. If root pixels are mistakenly grouped within a soil region, the similarity value 

should be lowered or the minimal pixel region size value decreased.  

 

 

 

Table 1.1 The optimal similarity values and minimal region pixel size used in 
SPRING for the segmentation of rhizotron, minirhizotron, and microcosm imagery. 
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Fig. 1.3a 

Fig. 1.3b 

Fig. 1.3c 

Figure 1.3 Segmentation and classification of a microcosm image in SPRING: (a) 
image imported into SPRING, (b) same image segmented into pixel regions for 
classification, (c) resulting classified image from pixel regions divided into 6 classes.   
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Once the classification is satisfactory, the single band image can be imported into 

ArcMap for further spatial analysis. The classified image is turned into vector data, in the 

form of polygons, and assigned a classification group. Using the Vectorization tool called 

Generate Features, centerlines are drawn through each root and average diameter is 

calculated. Areas of soil coloration are also measured here.  

1.3.3 SPRING method in use 

As a test of the versatility of SPRING segmentation and classification we classified 

different images, starting with the more complex microcosm images (Fig. 1.4). These 

images have a large variety of soil color; in some instances the color of the peat soil 

matched the color of fine roots. Figure 4a also had areas of blackening around roots that 

are of interest, as they likely indicate root-mediated oxidation of the rhizosphere in an 

otherwise anaerobic soil environment, and so they received a separate class as well (Fig. 

1.4b).  The resulting classification (Fig. 1.4b) has two peat classes, dark brown peat and 

light brown peat (transparent in figure); two root classes, main roots (fuchsia) and fine 

roots (cyan); and one class for blackened peat (navy). The best segmentation threshold 

for the microcosm images was a similarity value of 5 and a 20 pixel minimum region size 

value (Fig. 1.4). Having a small value for similarity was necessary to ensure that the ends 

of the fine roots were not classified as soil, and the minimum size of 20 was necessary to 

consistently separate the fine roots from the peat.  
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We next analyzed mosaicked minirhizotron images using the SPRING method (Fig. 

1.5). The best classification results were achieved when the images are broken into 

subsets, as we had issues with lighting and inconsistent settings between image frames.  

For the minirhizotron images, optimal similarity and minimal pixel region size varied by 

plant root type. Figure 1.5a is an image of a sedge (Carex spp.) root growing in peat with 

gas bubbles. Figure 1.5b displays the classification resulting from a similarity value of 20 

and minimal pixel region size of 100. The minimal pixel region size of 100 proved 

optimal given the clear color distinction between root, gas bubbles, and peat.  

 

Figure 1.4 Microcosm image which has been segmented and classified: (a) 
microcosm image, (b) polygons produced from SPRING classification superimposed 
over the microcosm image.  

Fig. 1.4a Fig. 1.4b 
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The second set of minirhizotron images in Figure 1.6 demonstrates the propensity of 

peat to shift over time, one of the unique properties of peatland soil and a significant 

challenge for root analyses (Iversen et al., 2012). To overcome this challenge SPRING 

was used to segment and classify the first image. The frame of a normal minirhizotron is 

shown in green, first position of the root is depicted in Figure 1.6a, yellow arrow. Over a 

month that same root has shifted out of the original frame into one below it (Fig. 1.6b, 

Figure 1.5 SPRING-classified mosaicked minirhizotron image: (a) the input image, 
(b) classification results superimposed over the image. 

Fig. 1.5a Fig. 1.5b 
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yellow arrow), normally that would signify the disappearance of a root. With this method 

we are able to copy the last session’s tracings and shift them down and update the shape 

for growth as needed, while maintaining the same identity. The attributes from each table 

can be subtracted one from the other to measure the growth of individual roots. This is 

where these methods have strengths over other programs, because we are making direct 

image to image comparisons. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.6 SPRING-classified mosaicked minirhizotron image, green box represents 
the extent of a single minirhizotron image: (a) image from 6-11-2014 with the 
classification results superimposed over the image, (b) image from 7-10-2014 with the 
same classification results from 6-11-2014 superimposed over the image and shifted 
down with moving soil matrix.  

Fig. 1.6a Fig. 1.6b 
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To demonstrate the SPRING method on images from a less complex, but by no means 

uniform, mineral soil matrix we used rhizotron images of deciduous tree roots growing in 

a sandy mineral horizon (Figs. 1.7 a,b,c). These, which were collected using an infrared 

light source to minimize effects on roots, had segmentation performed using only the blue 

and green bands, because these bands displayed more contrast between soil and roots, 

providing better segmentation and classification results. We then performed classification 

and had one root class and one soil class. As in the minirhizotrons, using a larger 

similarity value and minimal pixel region size forced larger soil and root regions together.  
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1.3.4 Validation of SPRING method 

 To evaluate the results of our SPRING method vs. a standard hand tracing method, 

we took 25 images of different color and diameter string and wire overlaid on soil in 

microcosms (Table 1.2). These images were captured with the same camera system used 

for the microcosms. Images were analyzed with the SPRING method and manual 

vectorization using Rootfly (http://www.ces.clemson.edu/~stb/rootfly), a freely available 

and widely used image analysis software package. We compared root length, root 

diameter and image processing time in this method validation. To test the significance of 

the results a standardized student’s t-test (α=0.05 here and throughout) in R studio 

environment (R Core Team, 2008) was used. 

The ratio of actual length to measured lengths for both methods had a mean of 0.95 for 

manual tracing, and 1.02 using SPRING (Fig. 1.8a). Manual vectorizing differed from the 

true measurements (t=-3.4885, p<0.001, df=24), while the SPRING method did not 

(t=1.9247, p=0.066, df=24), indicating the SPRING method was more accurate.  

 

 

 

 

 

 

 

 

 

Figure 1.8 Boxplots illustrating the distribution of measured (a) length ratios and 
(b) diameter ratios relative to the true hand measurement using the SPRING or 
manual vectorization methods.  

Fig. 1.8a Fig. 1.8b 
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In comparing the ratios of true to measured diameters (Fig. 1.8b) we found manual 

tracing in Rootfly diverged from the true measurements much more than SPRING did. 

Manual tracing greatly overestimating diameters, with a mean ratio of 2.37 (t=27.40, p< 

0.001, df=24). Although the SPRING method also differed significantly from the true 

measurements (t=2.8753, p=0.008, df=24), the method was much more accurate (mean 

ratio of 1.12). When the diameter data were broken down into color class the SPRING 

method produced ratios closer to one for all four test materials (Table 1.2). Interestingly, 

whereas in most colors both methods overestimated root diameter, brown wire diameters 

were underestimated by SPRING (mean ratio 0.7) and overestimated by manual tracing 

(mean ratio 1.53), presumably reflecting the effect of lower contrast with the soil matrix.  

 

 

 

 

 

 

 

 

 

 

 

Table 1.2 Ratio and standard error of measured diameters to the true hand 
measurement using the SPRING method or manual tracing broken down by color. 
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Length Measured (mm) Hand Tracing SD SPRING SD n
1457 7.80 ±0.44 11.21 ±3.08 5
2501 21.17 ±5.49 15.28 ±1.74 6
4896 25.00 ±3.53 15.38 ±1.49 5
5005 31.20 ±7.45 14.48 ±1.20 10

Time (minutes)

In SPRING processing time did not vary significantly by root density, taking an 

average of 14 minutes an image, whereas processing time for manual tracing increased 

with complexity (8 to 39 minutes) (Table 1.3). Manual tracing had a marginally (p<0.1) 

lower processing time for low root density, marginally higher for medium root density, 

and significantly higher for both medium/high and high root density.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table 1.3 Distribution of time, in minutes, to execute either the SPRING method or 
manual tracing according to root density (total length).  
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To further test the accuracy of image classifications using SPRING, we used the 

procedure developed by Congalton & Green (1999) employing error matrices and kappa 

coefficients of agreement. Following their guidelines, 50 points per class were randomly 

placed over a classified image for each class using ArcMap, the user visually assessed the 

accuracy of classification, and the output was analyzed in Excel. Results showed overall 

classification accuracy above 90%, with a value above 80% considered to represent a 

very strong correlation between segmentation analysis and the true image (Landis and 

Koch, 1977) (Table 1.4). The Z-statistic for each image type indicated significant 

agreement between classified and true image (Table 1.4). The error matrix (Table S1.1) 

shows the instances where the sample points were classified correctly and which were 

most likely to be incorrectly classified. 

 

 

 

 

 

 

 

 

 

 

 

 

Table 1.4 A summary table of SPRING’s image classification accuracy (%), including 
the producer’s error, user’s error, overall accuracy, and the kappa coefficient of 
accuracy.  
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1.3.5 Change detection 

Once images are acquired, change detection based on image subtraction is another 

possible method to quantify root demography and other belowground dynamics. Image 

subtraction to detect change and quantify growth is a multi-step process. In cases where 

the images do not overlay one another exactly, the two images must be georeferenced to 

one another. After georeferencing, the next step is image subtraction, then thresholding, 

followed by reclassification, and lastly vectorization. Image thresholding is a form of 

image classification based strictly on BVs and the spatial relationship between pixels is 

ignored. Complex change images (Fig. 1.9) can be segmented and classified using 

SPRING in place of thresholding and vectorization. There are two ways to perform image 

subtraction in ArcMap. The first way is to use ArcMap’s Raster Calculator, where a 

single image is generated by subtracting one band from another. Alternatively ArcMap’s 

image analysis window has a change detection tool, which generates a temporary image 

based on differences between images. Remote sensing image processing software such as 

ERDAS Imagine (Hexagon Geospatial, Norcross GA) has a change detection wizard that 

will produce better change analysis results than ArcMap. ERDAS Imagine allows for a 

change detection sensitivity adjustment, meaning it is possible to output only values that 

have changed by a certain percentage. If ERDAS Imagine is available, using it is strongly 

advised to filter out BVs indicating minor changes. 

After image subtraction, image thresholding is performed in ArcMap to isolate BVs 

indicative of change. When the soil color does not change and the BVs are the same day 

to day, subtracting those pixels from another will produce no change. Soils with 

fluctuating color resulting from changes in moisture, disturbance, or redox reactions will 
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be quantified as change when using image subtraction; this can be sorted in the 

thresholding process. Instances of growth or root shift will be apparent in their pixel 

values. It is these values of no change, loss, or addition that we are classifying. The 

resulting raster from image subtraction will have pixel values that can be sorted into 

different classes in the image’s symbology properties simply by sliding the break value 

bars over the images pixel value histogram (see supplementary protocol). Once the image 

pixels are sorted into different classes, the Reclassify tool can be used to create a new 

raster layer sorted into classes with values of 0, 1, 2, 3, etc. depending on how many 

classes are needed. These classes can be converted into polygons using the Raster to 

Polygon tool. Within this new layer’s attribute table, Calculate Geometry can solve for 

areas of growth or change. 

 

1.3.6 Change detection in use 

We tested change detection in four different sets of images. The microcosm (Fig. 1.9) 

and mosaicked minirhizotron images (Fig. 1.10) were both processed for change 

detection the same way, using the image difference tool in ArcMap’s Image analysis 

window. The microcosm image had many changing elements from week 1 (Fig. 1.9a) to 

week 3 (Fig. 1.9b), such as main and fine root growth and loss of peat blackening (Fig. 

1.9c). We found classification and segmentation of the change detection image in 

SPRING, rather than thresholding, to produce the best results (Fig. 1.9d). The resulting 

polygons of SPRING segmentation and classification were used to calculate new root 

growth and loss of peat blackening (Fig. 1.9d). 
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Two different sets of minirhizotron images were analyzed with change detection. The 

first example (Fig. 1.10) demonstrates the change detection method in a minirhizotron 

environment. Minor peat shifts from month to month were corrected with georeferencing 

prior to change detection; however major shifts in soil matrix may not permit 

georeferencing as the distortion could be too great. Change detection was performed on 

the blue bands from week 1 (Fig. 1.10a) and week 4 (Fig. 1.10b). The appearance of a 

new root is displayed in black (Fig. 1.10c) in the resulting image. To extract the values 

associated with the new root, the image underwent thresholding, reclassification, and 

raster to polygon conversion. Following conversion the resulting new root polygon was 

selected and exported to produce its own layer (Fig. 1.10d). If there were multiple new 

roots or any other new phenomena of interest those polygons could be selected and made 

into a layer as well.    

 

 

 

 

 

 

 

 

 

 

 
Fig. 1.10a Fig. 1.10b Fig. 1.10c Fig. 1.10d 

Figure 1.10 Minirhizotron change analysis II root and peat displacement: (a) week 
one imagery, (b) week 4 imagery, (c) results from thresholding change analysis.  
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Using rhizotron imagery, we performed change detection on a series of 17 images of a 

mycorrhizal fungal hyphal fan to observe change over time (Fig. 1.11). This fan 

displayed remarkable growth from week 1 (Fig. 1.11a) to week 26 (Fig. 1.11b). We used 

ArcMap’s Raster Calculator to execute image subtraction in the blue band, as it had the 

most contrast between hyphae and soil. Within ArcMap’s Raster Calculator tool we 

selected week n and subtracted it from the week n-1 image. Image subtraction, 

thresholding, reclassification, and vectorization resulted in polygons delineating growth 

at approximately biweekly intervals.  These polygons were stacked over one another (Fig. 

1.11c) to display growth dynamics. The polygons all have a known area that can be used 

to quantify growth.   
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1.3.7 ArcMap Spatial Analysis of classified or change detection imagery 

Spatial analysis is the final step following segmentation and classification in SPRING 

or change detection. Either method results in polygons with their own identities. The first 

step in spatial analysis is determining the spatial scale (see Supplemental protocol). Once 

the scale is known, area and perimeter of each polygon can be calculated automatically in 

the ArcMap attribute table using Calculate Geometry, then rescaled. Object (root, soil 

patch, worm burrow, etc.) diameters and lengths are also calculated automatically with 

Vectorization (see Supplemental protocol). With the Field Calculator any equation for 

further quantitative analysis can be entered, such as surface area or volumes. The 

Summarize Tool in the attribute table will generate statistics on total lengths for each 

field or areas (see Supplemental protocol). 

In ArcMap there is access to additional functions that can enhance the image analysis 

of these complex soil environments.  With the Measure Tool we are able to generate 

exact measurements of root depth in minirhizotron tubes. With the Identify Cursor, we 

are able to obtain true color values for each band. In addition, fields can be created in the 

attribute table for additional root data (e.g., branching order, species). Chemical analysis 

from points of interest could be performed and imported into ArcMap as point data, 

allowing an in-depth spatial study of biogeochemical processes in the rhizosphere. 

ArcMap also has a powerful suite of spatial statistics tools allowing the user to measure 

relationships between sets of data, thus integrating data processing and statistical 

analysis.    
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Concluding remarks 

The application of our approaches to image analysis can enhance understanding of 

belowground ecosystem processes. Our appended protocols, combined with basic 

training in GIS methods, permit application of our methods in complex soil matrices. 

With the use of these methods we were able to delineate areas of roots, mycorrhizal 

hyphae, soil redox, and gas bubbles from imagery in a natural environment.  

Our semi-automated methodologies clearly outperformed manual-tracing methods of 

vectorization in both time and accuracy. With increasing root density, processing time did 

not increase and accuracy did not decrease. In imagery where soil matrix and roots had 

good color distinction it was easy for SPRING to accurately differentiate and classify 

relevant features. The greatest challenge for all methods, including ours, is areas of low 

contrast between matrix and object of interest.  

These methods proved to be capable of processing large sets of complex data rapidly. 

Working with SPRING’s image segmentation and classification algorithms in 

conjunction with ArcMap users can employ readily available powerful semi-automated 

tracing algorithms, within a user-friendly program where coding with is not required. 

Errors from SPRING are also easily corrected in ArcMap’s point-and-click environment.  

Mosaicking minirhizotron images together for analysis was advantageous in terms of 

processing time, as well as for dealing with shifting positions of roots in peat over time. 

With one consecutive image we were easily able to observe and note large root 

displacement, especially when displacement was along the vertical axis. This is 

impossible for unmosaicked images.  



 

34 
 

In conclusion, our methodologies permit root demographic analysis of more complex 

images than standard root analysis methods, as well as belowground image analysis 

beyond root demographics. By facilitating application of GIS and remote sensing image 

processing technologies in this novel arena we expect to enhance the rate of scientific 

progress in belowground ecosystem research.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

35 
 

1.5 References  

Bins LS, Fonseca LM G, Erthal G J, Ii FM 1996. Satellite imagery segmentation: a 

region growing approach. Simpósio Brasileiro de Sensoriamento Remoto 8: 677-

680. 

Câmara G, Souza RCM, Freitas U M, Garrido J. 1996. SPRING: Integrating remote 

sensing and GIS by object-oriented data modelling. Computers & graphics 20: 

395-403. 

Chapin FS, and Ruess RW . 2001. Carbon cycle: The roots of the matter. Nature 411: 

749-752. 

Christensen, PB,  Revsbech, N P, Jensen, KS. 1994. Microsensor analysis of oxygen in 

the rhizosphere of the aquatic macrophyte Littorella uniflora (L.) 

Ascherson. Plant Physiology 105: 847-852. 

Congalton RG, Green K. 1999. Assessing the accuracy of remotely sensed data: 

principles and practices. Lewis Publishers. New York: 137. 

Downie HF, Adu MO, Schmidt S, Otten W, Dupuy LX, White PJ, Valentine TA. 

2014. Challenges and opportunities for quantifying roots and rhizosphere 

interactions through imaging and image analysis. Plant, cell & environment. 

ESRI (Environmental Systems Resource Institute). 2014. ArcGIS Desktop: Release 

10.1. Redlands, CA: Environmental Systems Research Institute.  

Farrar JF, Jones DL. 2000. The control of carbon acquisition by roots. New 

Phytologist 147, 43-53. 



 

36 
 

French A, Ubeda-Tomás S, Holman T J, Bennett MJ, Pridmore T. 2009. High-

throughput quantification of root growth using a novel image-analysis tool. Plant 

physiology 150: 1784-1795.  

Gasch CK, Collier TR, Enloe SF, Prager SD. 2011. A GIS-based method for the 

analysis of digital rhizotron images. Plant Root 5, 69–78. 

Gijsenij A, Lu R, Gevers T. 2012. Color constancy for multiple light sources. Image 

Processing, IEEE Transactions on 21, 697-707. 

Iversen C M, Murphy MT, Allen MF, Childs J, Eissenstat DM, Lilleskov EA, 

Sullivan PF. 2012. Advancing the use of minirhizotrons in wetlands. Plant and 

soil, 352: 23-39. 

Jackson R, Moone, HA, Schulze ED. 1997. A global budget for fine root biomass, 

surface area, and nutrient contents. Proceedings of the National Academy of 

Sciences 94: 7362-7366. 

Johnson JF, Allmaras RR, Reicosky DC. 2006. Estimating source carbon from crop 

residues, roots and rhizodeposits using the national grain-yield 

database. Agronomy journal 98. 622-636. 

Landis JR, Koch GG. 1977. The measurement of observer agreement for categorical 

data. Biometrics: 159-174. 

Majdi H. 1996. Root sampling methods-applications and limitations of the minirhizotron 

technique. Plant and Soil, 185(2): 255-258. 

Milchunas DG. 2009. "Estimating root production: comparison of 11 methods in 

shortgrass steppe and review of biases." Ecosystems 12: 1381-1402. 



 

37 
 

Persichetti P, Simone P, Langella M, Marangi GF, Carusi C. 2007. “Digital 

photography in plastic surgery: how to achieve reasonable standardization outside 

a photographic studio.” Aesthetic plastic surgery, 31: 194-200. 

Pierret A, Moran CJ, Doussan C. 2005. “Conventional detection methodology is 

limiting our ability to understand the roles and functions of fine roots.” New 

Phytologist, 166: 967-980. 

Plataniotis KN, Venetsanopoulos AN. 2000. Color image processing and applications. 

Springer. 

Plourde L, Congalton RG. 2003. Sampling method and sample placement: how do they 

affect the accuracy of remotely sensed maps. Photogrammetric Engineering and 

Remote Sensing 69: 289-297. 

R Development Core Team. 2008. R: A language and environment for statistical 

computing. R Foundation for Statistical Computing, Vienna, Austria. ISBN 3-

900051-07-0, URL http://www.R-project.org. 

Rasse DP, Rumpel C, Dignac MF. 2005. Is soil carbon mostly root carbon? 

Mechanisms for a specific stabilisation. Plant and soil 269: 341-356. 

Rewald B, Ephrath JE. 2012. Minirhizotron technique. Plant roots: the hidden half, 4th 

edn. CRC Press, New York. 

Rossner M, Yamada KM. 2004. What's in a picture? The temptation of image 

manipulation. The Journal of Cell Biology 166: 11-15. 

Schmidt MW, Torn MS, Abiven S, Dittmar T, Guggenberger G, Janssens IJ, Kleber 

M, et al. 2011. Persistence of soil organic matter as an ecosystem 

property. Nature 478: 49-56. 



 

38 
 

Shojaedini SV, Heidari M. 2013. A New Method for Root Detection in Minirhizotron 

Images: Hypothesis Testing Based on Entropy-based Geometric Level Set 

Decision. International Journal of Engineering 1: 1. 

Singh A. 1989. Review Article Digital change detection techniques using remotely-

sensed data. International Journal of Remote Sensing 10: 989-1003. 

Smithwick EA, Lucash MS, McCormack ML, Sivandran G. 2014. Improving the 

representation of roots in terrestrial models. Ecological Modelling 291: 193-204. 

Taylor BN, Beidler KV, Strand AE, Pritchard SG. 2014. Improved scaling of 

minirhizotron data using an empirically-derived depth of field and correcting for 

the underestimation of root diameters. Plant and Soil 374: 941-948. 

Trumbore S, Da Costa ES, Nepstad DC, Barbosa De Camargo P, Martinelli LA, 

Ray D, Silver W. 2006. Dynamics of fine root carbon in Amazonian tropical 

ecosystems and the contribution of roots to soil respiration. Global Change 

Biology 12: 217-229.  

Wan S, Norby RJ, Pregitzer KS, Ledford J, O’Neil EG. 2004. CO2 enrichment and 

warming of the atmosphere enhance both productivity and mortality of maple tree 

fine roots. New Phytologist 162: 437-446.  

Vamerali T, Bandiera M, and Mosca G. 2012. Minirhizotrons in modern root 

studies. Measuring roots. Springer Berlin Heidelberg: 341-361. 

Veresoglou SD, Chen B, Rillig MC. 2012. Arbuscular mycorrhiza and soil nitrogen 

cycling. Soil Biology and Biochemistry 46: 53-62. 



 

39 
 

Zeng G, Birchfield ST,  Wells CE. 2008. Automatic discrimination of fine roots in 

minirhizotron images. New Phytologist 177: 549-557. 

Zeng G, Birchfield ST, Wells CE 2010. Rapid automated detection of roots in 

minirhizotron images. Machine Vision and Applications 21: 309-317. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

40 
 

1.6 Appendix A 

Table of Contents: 

S1.1 Supplementary Protocol  ........................................................................................41 

S1.2 Supplementary Material  ........................................................................................61 

 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

41 
 

Giving images a false coordinate system 

Images are giving a false coordinate system using the Define Projection tool, found in the 

Data Management Projections and Transformations Toolbox in ArcMap. A UTM 

projection is needed so the images sit on a flat grid, we used NAD 83 UTM Zone 16N. 

Define Projection does not create a new image, it provides the images real coordinates. 

These coordinates will give each pixel a resolution or 1 meter, so rescaling is simple. 

If there are many images to give a projection to, use the Model Builder for batch 

processing. In place of using the Define Projection command for each image individual a 

model can be created which will repeat the command for each image automatically. 

Creating this model (Fig. S1.1) is done by opening a new model. Then insert→ iterators 

→Rasters, from here drag and drop a file on the Iterate Rasters hexagon, select 

workspace or catalog. If there is a folder with multiple subfolders containing images that 

need a projection, then double click on the iterate rasters hexagon, and select recursive. 

Selecting recursive enables ArcMap to go through all of the subfolders and define the 

projection for every image. After that bring the define projection tool into the model by 

selecting it from the toolbox and dragging it into the model, then selecting the UTM 

projection. Then press play (Fig. S1.1, red arrow). 

Figure S1.1 Example of a model for defining projections in ArcMap. 
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Spatial resolution calculations 

To solve for image spatial resolution use an image a ruler or any object with a known 

measurement. Give the image a false X, Y coordinate system. Images with a UTM 

coordinate system have each pixel representing 1 meter. So any measurement made in 

ArcMap can then be scaled appropriately easily.  Zoom in as close to the imaged ruler as 

possible to count how many pixels make up one millimeter (could use centimeters or 

nanometers). Divide the known length by the number of pixels spanned to solve for the 

length of one side of a pixel, this will provide the rescaling factor. For example, one 

millimeter on a ruler could span 10 pixels, which means each pixel is equal to 0.1 mm.  

Within the attribute table create a new field for length and use calculate geometry to 

solve for area of all root segments. Then create another field length_scaled type equals 

float, to rescale the results within the attribute table using the field calculator. Within the 

field calculator select [length] and multiply it by the rescaling factor.  

 

 *Calculate geometry and field calculator are found by right clicking on the field title 

within the attribute table. 
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SPRING flowchart 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.2 Steps taken to segment and classify an image in SPRING. The main steps 

are bold in text on the left. The blue arrows off the main steps are instruction to complete 

these steps.    
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Post SPRING Analysis 

 

Following SPRING Classification each image has to be converted to a Polygon layer, see 

section Converting SPRING imagery. After converting to a polygon the next step is 

dependent on your question, if only interested in areas, ArcMap calculates those 

automatically, see sections Editing classification errors in ArcMap, then Spatial 

resolution calculations, and Calculating areas and a building a richer dataset. If lengths 

and diameters are needed see sections: Thresholding, Vectorization and Raster Editing, 

then Calculating areas and a building a richer dataset. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.3 Post-SPRING analysis steps. 
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Converting SPRING imagery  

Once there is a classified image exported out of SPRING, export the original image as 

well. Instead of exporting as a Mono like with the classified image, export as RBG and 

fill each RBG Chanel with the associated band (Fig. S1.4). By exporting both images, 

realignment by georeferencing in ArcMap is avoided and the original and classified 

image will line up perfectly. Once both images are exported, use the Conversion tool > 

From Raster > Raster to polygon, this step is used to maintain the grid codes from 

SPRING indicating type and will allow us to edit errors in classification if any. 

 

Figure S1.4 Example of exporting an image from SPRING. 
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Editing classification errors in ArcMap 

Once there is a polygon version of a classified image and an exported original image, 

minor classification errors can be corrected. First display the polygon layer by the 

GRIDCODE using symbology. Then begin an editing session. Editing is best taught with 

ArcMaps tutorial found here: 

http://resources.arcgis.com/en/help/main/10.1/index.html#//01m500000003000000 

After editing move onto Spatial Resolution Calculations and then Calculating areas and 

a building a richer dataset.  

 

Thresholding  

Thresholding is the act of grouping pixels together based on their brightness value. To do 

this in ArcMap start with either a SPRING classified image (used for this demonstration) 

or an image produced from change analysis. First start by displaying the image from the 

Catalog into the Table of Contents (Fig. S1.5).  The values displayed are classes defined 

in SPRING. The values under the 0-1 layer class  represent soil and colored light green.  

Layer classes 1-5 are roots and are colored red or yellow and the 0 class (dark green) are 

values that were not classified. The image following (Fig. S1.5) had one soil class, an 

unclassified layer  and 4 root classes; these are the values to be used for thresholding. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure S1.5 The results of SPRING classification displayed in ArcMap. 
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The next step is to assign threshold classifications: click on the name of the image (Fig. 

S1.5, purple arrow) > select layer properties; this window will open (Fig. S1.6, blue 

arrow) > select the Symbology tab > Show > Classified (Fig. S1.6, red arrow). Then click 

on Classify (Fig. S1.6, orange arrow), the Classification window will appear (Fig. S1.6, 

green arrow). From here choose 2 classes as Vectorization requires a raster symbolized 

with 2 colors. The break values for this example will be 1.0 and 5, values between 1 and 

5 are roots and between 0 and .999999 are soil. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.6 Example of layer properties symbology and classification.  
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Once the values are changed, use the reclassify tool to create a new layer with two 

classes- root and background. The final reclassified image should like Figure S1.7.  

Then move on to Vectorization and Raster editing on the next page.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.7 Reclassified image. 
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Vectorization and raster editing 

To automatically measure for lengths and diameters of roots,use the ArcScan extension. 

Within the ArcScan extension is the Vectorization tool Generate Feature, which enables 

automated tracing. Follow the steps under Thresholding in ArcMap first. Once there is 

a reclassified layer with apparent root and soil zones use ArcScan’s Raster Cleanup to fix 

any errors.  In Figure S8 below we see an area of soil that is being classified as root 

(green arrow). To fix this begin with turning on the editor. First go to Customize > 

Toolbars > and check Editor, it should appear (red arrow).  Left click on Editor > Start 

Editing, select the image which needs to be edited. Then turn on ArcScan Customize > 

Extensions > ArcScan; once the ArcScan extension (blue arrow) is turned on, add the 

toolbar to the display Customize > Toolbars > and check ArcScan, then under Raster 

Cleanup select Start Clean up.  Within the ArcScan Toolbar turn on Raster Painting, 

Raster Clean up > Select Raster painting toolbar and it will appear (purple arrow). The 

steps to turn on the Editor, ArcScan, and Raster Painting should only need to be done 

once, then every time ArcMap is started the Editor should appear automatically.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.8 Using raster cleanup to fix errors from segmentation and classification. 
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Next, the eraser can be used to erase the small area of soil (Fig. S1.9). This is also where 

missing roots can be drawn in with the paint brush. The Magic Erase Tool can be used to 

erase entire segments, as displayed on the next page (Fig. S1.11 before editing and Fig. 

S1.12 after editing). A great trick for this kind of editing is to make the soil layer hollow, 

and add the original image behind it. In Figure S1.10 there is a bit of root that was left 

behind in classification, it can easily be “painted” back in. 

 

 

 

 

 

 

 

 

 

 

       

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.10 Missing end of a root 
after segmentation and classification. 

Figure S1.9 Edited root segment  

Figure S1.11: Reclassified 
segmented and classified image 
before editing.  

Figure S1.12 Same image from 
Figure 11 after editing.  
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Once the classified raster’s representation 

of the image is satisfactory, go to the 

editor, save all edits and stop editing. The 

next step is to convert the raster to a 

polygon again; this polygon layer will 

only have two grid codes, which is needed 

for Vectorization. Convert the second 

polygon layer to a polyline layer 

ArcToolbox > Data Management Rools > 

Features > Feature to Line.  To the new 

polyline layer add a field to the attribute 

table named diameter and set the type as a 

float. Resumeediting and select the 

polyline layer, go to Vectorization > 

Generate Features, and match the Generate Features 

window to Figure S1.13. Select okay, the tool will create new features and they will be 

highlighted in cyan. These features need to be made into their own layer, as right now 

they are a part of the polyline layer.  By right clicking on the polyline layer in the table of 

contents > Data> Export Data, save this layer in a Vectorized folder. Then use the Define 

Projection command again on the Vectorized layer and the first polygon layer.  

 

 

 

 

 

 

 

 

 

 

 

Figure S1.13 Generate features 
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Calculating areas and a building a richer dataset 

Following change analysis, SPRING classifiction or Vectorization, the analysis of 

resulting measurements can be made. Any additionally needed fields can also be added to 

the attribute table such as: length, length to scale, diameter and area to scale, depth, or 

color. Fields are added by selecting Table options > Add Field in the attribute table.  

Field types for numerical values should be designated as  floatsand any notes should be 

designated as  text fields. Length and areas are calculated automatically with Calculate 

Geometry. Use the Field Calculator to scale automatically calculated lengths and areas 

down. Use Statistics to find the sum, average, or min, and max values of each field. Field 

Calculator, Calculate Geometry, and Statistics are all found by right clicking on the name 

of a field (Figure S1.14). Use the measure tool (Fig. S1.15, blue arrow) to generate 

manually measured diameters and rooting depth (remember 1 meter with a UTM 

coordinate systems equals 1 pixel). Use the identify cursor (Fig. S1.15, red arrow) to find 

the red, green, and blue values. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.14 Using Field Calculator, Calculate Geometry, or Statistics in an example 
attribute table. 
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Note: If the measure tool is grayed out, right click on Layers (Fig. S1.15, green arrow), 

select Properties…, then Coordinate System, and select the coordinate system being used 

as the false coordinate system.  

 

 

 

 

 

 

 

 

Figure S1.15 Location of the Identify and Measure tool and display of the Identify 
window. 
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**If there is interest in the classes established in SPRING, use the intersect tool, 

Geoprocessing > Intersect (Figure S1.16). To intersect the vectorized layer ranked 1 and 

the polygon1 layer ranked 2. This will add the grid codes to the vectorized layer. The new 

layer will now have a series of grid codes (root type class from SPRING), lengths, and 

diameters for each root individually.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure S1.16 Intersect tool interface 
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Figure S1.17 Create Feature 
Class tool location and 
i f

Figure S1.18 Example of how to enter the 
Feature Class Location. 

Manually digitizing roots in ArcMap 

In overly complex root systems, manual digitizing could still be the best method for 

analysis. Using ArcMap for tracing roots by hand is simple and easier to work with them 

programs specifically designed for roots.  

Step one: Make a blank feature class.  

 

 

 

 

 

 

 

 

 

In ArcToolbox>Data Management 

Tools>Feature Class>Create Feature 

Class (Fig. S1.17). Once within the tool, 

the first required input is a folder for the 

new feature class. Select the map to 

folder button (Fig. S1.17 blue arrow), 

navigate to the location to save the 

digitized root layers, and create a new folder in this location.  Once a new folder is 

created, select it with a single left click. The name should appear (Fig. S1.18, red arrow).  
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Fig. S1.19: Example of the Create Feature Class interfaced with all required inputs. 

Then next input is name of the feature class, in this case fine roots, which will be 

namedS10_2012_06_13_fineroots (no spaces) (Fig. S1.19). The geometry type will be a 

polyline, as it will be traced along the center of root. The last input is a coordinate 

system; any UTM coordinate system can be used.  Leave the rest of the input options as 

the default.  
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Figure S1.21 Location of the Create 
Features editing window in the Editor 

Figure S1.20 Example of a detailed attribute 
table. 

Add the new feature class to the ArcMap Table of Contents. From here additional 

columns can be added to the attribute table for additional required data (lengths, colors, 

depths, etc.). Open the attribute table. Then add a field, for example length and make it a 

float. Fields can also be created for diameter, root depth, branching order, and red, green, 

blue values, and these will all be designated as float type. The resulting attribute table 

should look something like Figure S1.20. 

 

Step two: Digitize roots. 

Go to the editor toolbar and 

select start editing. Once editing 

is started, go back into the 

Editor toolbar>Editing 

Windows>Create Features (Fig. 

S1.21). This will bring up the 

create features window (Fig. 

S1.22). Select the blank feature 

class with a single left click to 

activate the construction tools.   
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Figure S1.22: Create Features editing 
i d

Figure S1.23 Vectorizing roots.  

Use either the line or freehand tool to draw a center line through the root. The freehand 

tool will enables the user to draw a curved line by single clicking the starting point and 

then the ending point (Fig. S1.22, green arrow). The line feature will require multiple 

clicks along the root, then a double click to end the line (Fig. S1.23, purple arrow). 
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After a root vector is created, additional information can be added to the attribute table 

pertaining to that root segment (see Calculating areas and building a richer data set). 

Save edits often and when finished select Stop editing from the editor toolbar. Lastly, 

rescale the data by adding two new fields one for the true length and one for true 

diameter.Use the Field Calculator to multiply length and/or diameter by the rescaling 

factor.  

When solving for lengths over consecutive dates , and there is a need to alter the tracing 

from the a previous date’s image,  simply right click and copy the feature class from the 

table of contents in ArcMap, and paste into a new location. Rename the feature class by 

right clicking and selecting rename. Begin a new editing session and change to locations 

or lengths. Legth and diameter will need to be re-calculated and rescaled once finished 

altering the tracing. 

 

*Potential Issue: The Halo effect- Reflection from the root to the glass adding a “glow” 

around the root. In the Figure S1.24 example, it is known that this root is truly 3 μm in 

diameter, not 5.29 μm. From a distance (Fig. S1.24 ) you cannot tell there is a reflection 

off the root to the glass, but when zoomed in you can see pixels that are very white and 

pixels that are tan/gray in color (Fig. S1.25), which demonstrates the importance of 

working at the pixel level,. Keep this in mind when looking at vectorization results, and if 

during segmentation the halo was included in your results, you will want to scale the 

measurements down. Further work in the development of an algorithm to mask the halo 

around a root is needed. This could be a cause in overestimation in many root tracing 

systems.  
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Figure S1.24 Image of roots where the diameter is 
measured from a far (not at pixel level). 

Figure S1.25 Image of  root where the diameter 
measurement is acquired at the pixel level.  
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Saving imagery 

Image compression should never be used when saving images. Compression algorithms 

eliminate redundant information for storage, once displayed again the image might look 

fine at full scale, but when zoomed to the pixel level there is a significant difference in 

quality. A loss of detail at the pixel level is significant when imaging roots that are 

originally only a pixel or two wide. Compression also leads to changes in color, which is 

important to consider if measuring colors. Images should always be stored as an 

uncompressed .tiff or .img; compressed formats such as a .jpg should be avoided. 

*Try it out- Save a RAW image as a.jpg and as a .tiff and zoom in to both levels. Try 

different levels of JPEG compression. There will be a noticeable difference at the pixel 

level.  

 

 

 

 

 

 

 

 

 

 

 



 

62 
 

Root Soil Row Total
Root 44 6 50
Soil 3 47 50

47 53 100

Root Soil Row Total
Root 48 2 50
Soil 0 50 50

48 52 100

Root Fine Root Peat Dark Peat Row Total
Root 43 1 0 1 45

Fine Root 2 42 5 1 50
Peat 5 0 50 0 55

Dark Peat 0 1 2 47 50
Column Total 50 44 57 49 200

Minirhizotron

Microcosm

Column Total

Column Total

Rhizotron

1.2 Supplementary Material: 

Table S1.1: The error matrix demonstrates SPRING’s ability to segment and classify and 

image accurately, it is produced by randomly testing 50 points per image classification 

and comparing SPRING classification to the true class. 
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1.7 Appendix B 

# Code that automates stitching together minirhizotron images 

import arcpy 
import os 
import sys 
from arcpy.sa import * 
 
from arcpy import env 
 
# Set the current workspace 
 
env.workspace= 
"I:/Mesocosm/QAQCimages/Minirhizotron2011/July2011/Bin01_08032011/Turn2" 
maindir = str(env.workspace) 
 
rasterList = arcpy.ListRasters() 
for raster in rasterList: 
    print raster 
 
#Define projection 
for raster in arcpy.ListRasters(): 
 #print raster 
 arcpy.DefineProjection_management(raster, 
"PROJCS['NAD_1983_UTM_Zone_16N',GEOGCS['GCS_North_American_1983',DAT
UM['D_North_American_1983',SPHEROID['GRS_1980',6378137.0,298.257222101]],P
RIMEM['Greenwich',0.0],UNIT['Degree',0.0174532925199433]],PROJECTION['Transv
erse_Mercator'],PARAMETER['False_Easting',500000.0],PARAMETER['False_Northin
g',0.0],PARAMETER['Central_Meridian',-
87.0],PARAMETER['Scale_Factor',0.9996],PARAMETER['Latitude_Of_Origin',0.0],U
NIT['Meter',1.0]]") 
 #print "defined projection for" + str(raster) 
 
#Clip rasters and create a new folder in the dirctory for them to go 
 
cropped_newpath = str(maindir) + "/" + "cropped" 
if not os.path.exists(cropped_newpath): os.makedirs(cropped_newpath) 
 
##Clip Raster Dataset by known extent - Left Bottom Right Top 
 
env.workspace= maindir 
outputworkspace= cropped_newpath 
rasterList = arcpy.ListRasters() 
for raster in arcpy.ListRasters(): 
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    raster1=str(outputworkspace) + "/" + str(raster[:-4]) 
    arcpy.Clip_management(raster, "-0.5 -520.5 729.5 -7.5", str(raster1 + ".img")) 
 
#Create file for shifted images 
 
shift_newpath = str(maindir) + "/" + "shiftimages" 
if not os.path.exists(shift_newpath): os.makedirs(shift_newpath) 
 
#Shift images 
 
env.workspace= cropped_newpath 
outputworkspace= shift_newpath 
xdir=1 
float(xdir) 
xinc=1 
float(xinc) 
ydir=-485 
float(ydir) 
yinc=-485 
float(yinc) 
rasterList = arcpy.ListRasters() 
for raster in arcpy.ListRasters(): 
    print raster 
    raster2=str(outputworkspace) + "/" + str(raster[:-4]) 
    arcpy.Shift_management(raster, str(raster2 + ".img"), xdir, ydir) 
    xdir= xdir+xinc 
    ydir= ydir+yinc 
 
 
#Create folder for mosiac image 
 
final_newpath = str(maindir) + "/" + "finalimage" 
if not os.path.exists(final_newpath): os.makedirs(final_newpath) 
 
#Mosiac images 
 
env.workspace= shift_newpath 
outputworkspace= final_newpath 
rasterList = arcpy.ListRasters() 
 
# Set local variables 
outname = "Tube1_T2_Bin1BDate08_03_11.gdb" 
 
# Execute CreateFileGDB 
GDB = arcpy.CreateFileGDB_management(outputworkspace, outname) 
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gdbname = GDB 
mdname = "MosiacDataset" 
prj = 
"PROJCS['NAD_1983_UTM_Zone_16N',GEOGCS['GCS_North_American_1983',DAT
UM['D_North_American_1983',SPHEROID['GRS_1980',6378137.0,298.257222101]],P
RIMEM['Greenwich',0.0],UNIT['Degree',0.0174532925199433]],PROJECTION['Transv
erse_Mercator'],PARAMETER['False_Easting',500000.0],PARAMETER['False_Northin
g',0.0],PARAMETER['Central_Meridian',-
87.0],PARAMETER['Scale_Factor',0.9996],PARAMETER['Latitude_Of_Origin',0.0],U
NIT['Meter',1.0]]" 
noband = "3" 
pixtype = "8_BIT_UNSIGNED" 
pdef = "NONE" 
wavelength = "" 
 
mosaic_dataset = arcpy.CreateMosaicDataset_management(gdbname, mdname, prj, 
noband, pixtype, pdef, wavelength) 
 
 
#Add Raster Dataset type Raster to FGDB Mosaic Dataset 
#Calculate Cell Size Ranges and Build Boundary 
#Build Overviews for Mosaic Dataset upon the 3rd level Raster Dataset pyramid 
#Apply TIFF file filter 
#Build Pyramids for the source datasets 
 
mdname = mosaic_dataset 
rastype = "Raster Dataset" 
inpath = shift_newpath 
updatecs = "UPDATE_CELL_SIZES" 
updatebnd = "UPDATE_BOUNDARY" 
updateovr = "UPDATE_OVERVIEWS" 
maxlevel = "" 
maxcs = "#" 
maxdim = "#" 
spatialref = "#" 
inputdatafilter = "*.img" 
subfolder = "NO_SUBFOLDERS" 
duplicate = "EXCLUDE_DUPLICATES" 
buildpy = "NO_PYRAMIDS" 
calcstats = "CALCULATE_STATISTICS" 
buildthumb = "NO_THUMBNAILS" 
comments = "Add Raster Datasets" 
forcesr = "#" 
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Mosiac = arcpy.AddRastersToMosaicDataset_management(mdname,  rastype, inpath, 
updatecs, updatebnd, updateovr,maxlevel, maxcs, maxdim, spatialref, 
inputdatafilter,subfolder, duplicate, buildpy, calcstats, buildthumb, comments, forcesr) 
 
#Set mosiac dataset properties 
 
Mosiac2 = 
arcpy.SetMosaicDatasetProperties_management(Mosiac,"","","","None","","","","NOT_
CLIP","FOOTPRINTS_MAY_CONTAIN_NODATA","","NOT_APPLY","","","","Non
e","","","DESCENDING","BLEND","13","","","","","","FULL","","DISABLED","","","
","","","") 
 
arcpy.BuildSeamlines_management(Mosiac2, "","NORTH_WEST", "#", "#", "#", 
"#","RADIOMETRY", "10", "BOTH", "#", "#") 
#Make Mosiac a Tiff 
arcpy.CopyRaster_management(Mosiac2, str(final_newpath) + "/" + "final") 
print "finished!" 
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